If you do not already have CodeSys on your PC then go to the link below to create an

account.

https://us.store.codesys.com/customer/account/create/

Sign in to your new CodeSys account and download CODESYS Development System V3.
This download is about 1.3Gb.

CODESYS Development System V3

Download 32 Bit Download 64 Bit

The CODESYS Development System is the IEC 61131-3 programming tool for industrial control and automation
technclogy, available in g 32-bit and a 64-bit version.

CODESYS
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CODESYS 64
Double Click Install File SEEARAEE

If you are asked to install additional requirements, please follow the prompts to do so.

This is the Codesys installer — Click Next

Welcome to the InstallShield Wizard for
CODESYS 64 3.5.21.0

The InstallShield(R) Wizard will install CODESYS 64 3.5.21.0 on
your computer. To continue, dick Next.

WARNING: This program is protected by copyright law and
international treaties.

m




Select “l accept the Terms in the License Agreement” and Click Next

© CODESYS 64 3.5.21.0 - InstallShield Wizard X

License Agreement .
Please read the following license agreement carefully. CODESYS

License Agreement |
for the usage of a CODESYS Software or CODESYS

Software Package

General Terms of License (End User License
Agreement) for the supplied Software. Please read
this Software User Agreement carefully before using
the supplied Software. Downloading or installation of

b Calfliiimean nanmmbidbidam vanamedine b btlha Avimbamane

Print

© 1 accept the terms in the license agreement
()1 do not accept the terms in the license agreement )
Open Source Licenses

InstaliShield

=

Select “l have read the information” and Click Next

© CODESYS 64 3.5.21.0 - InstallShield Wizard

Release Information

Please read the following information. CODESYS

Click the link to show the Release Notes

Release Notes

© I have read the information
(O 1 have not read the information yet

InstallShield

<o Carcs
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If you want to change the location for the download, do so now or Click Next to install to
the default location.

© CODESYS 64 3.5.21.0 - InstallShield Wizard

Destination Folder <=
Click Next to install to this folder, or dick Change to install to a different folder. CODESYS
—, Install CODESYS 64 3.5.21.0 to:
C:\Program Files\CODESYS 3.5.21.0\ Change...

InstallShield

<on cacs

Select Complete and Click Next

© CODESYS 64 3.5.21.0 - InstallShield Wizard

Setup Type .‘
Choose the setup type that best suits your needs. CODESYS

Please select a setup type.

© Complete
All program features will be installed. (Requires the most disk
space.)

() Custom

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

InstaliShield

<on cares

Ready for Installation. Click Install



& CODESYS 64 3.5.21.0 - InstallShield Wizard

Ready to Install the Program

B

The wizard is ready to begin installation. CODESYS

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

InstaliShield

Once everything is finished (takes some time) you will see this screen. Click Finish.

& CODESYS 64 3.5.21.0 - InstallShield Wizard

InstaliShield Wizard Completed

The InstallShield Wizard has successfully installed CODESYS 64
3.5.21.0. Click Finish to exit the wizard.
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CODESYS

Open the Codesys Software/MEaEiie

We want to install any available updates at this time.

Click on Tools->CODESYS Installer

@Y CODESYS

File Edit View Project Build Online Debug | Tools | Window Help
BEFEH & v o« § B R X |44 4 M L I‘jﬁ CODESYS Installer... |
' m Library Repository...
Devices v 3 X @ Device Repository...
s @] Visualization Element Repository
@ Visualization Style Repository...

If the Installer tells you there is an update and to Restart as Administrator, on the bottom of
the Installer Window, Click (Restart as Administrator).

€% CODESYS Installer = [m] X

CODESYS 643.5.21.0

C:\Program Files\CODESYS 3.5.21.0\CODESYS Browse } > Start

Releases ~ Releases - Al =
s s
Installed Browse Updates * Install File(s)
0
O Search Y v 4

[0 38 CODESYS Application Composer

[ 28 CODESYS Automation Server Connector
[ 28 CODESYS Base Libraries

[ 28 CODESYS C Code Integration

[ 52 CODESYS CANopen

() 88 CODESYS CFC

[ 22 CODESYS Code Generator ARM

[ 22 CODESYS Code Generator ARM64

Copyright © 2024 CODESYS Development GmbH Read-Only Mod‘ (Restart as A ) '
S —




This will reopen the Installer. Follow any instructions on updating the software.

% Update available X

Update is available
2.4.0 -> 2.41

Do you want to install the update?

Skip this version Remind me later

This update took a very long time to complete. Once complete follow the prompts to
reopen the software.

Now we need to check for Add-on Updates. Reopen the Installer in Admin Mode again,
Click on Updates, then Click on Check for Updates

% CODESYS Installer

CODESYS 643.5.21.0

C:\Program Files\CODESYS 3.5.21.0\CODESYS [ Browse } [ » Start

Channel for Setups hannel for Add-ons Update Mode
Releases ~ Releases ~ Al

t :
Installed Browse 2 InstallFile(s)
Search

C Check for Update

Copyright © 2024 CODESYS Development GmbH




When the list of updates populates, Select All boxes and Click on Update Selected

% CODESYS Installer = o X

CODESYS 643.5.21.0

E:\P;ogram Files\CODESYS 3.5.21.0\CODESYS

Channel for Setups Channel for Add-ons Update Mode
Releases ~ Releases > Al v

Update Selected * Install File(s)

Installed Browse Updates

‘ 'Z\ea'm f® v

22 CODESYS Recipes

22 CODESYS Ladder

52 CODESYS PROFIBUS

52 CODESYS Automation Server Connector
82 CODESYS Communication

8¢ CODESYS Visualization ~ Security

82 CODESYS SoftMotion

Copyright © 2024 CODESYS Development GmbH

A Confirmation Required box pops up, Click OK

% Confirmation Required X

The following operations will be performed.
Click OK to proceed with the changes listed below.

==== Packages aktualisieren ====

Install Packages (Silent=False, IncludeDependencies=True)
InstallationPath: ‘C:\Program Files\CODESYS 3.5.21.0\CODESYS'
- CODESYS Redundancy, Version 4.2.0.0
- CODESYS Visualization Support, Version 4.6.0.0
- CODESYS Recipes, Version 4.6.0.0
- CODESYS Ladder, Version 1.2.0.0
- CODESYS PROFIBUS, Version 4.2.0.0
- CODESYS Automation Server Connector, Version 1.36.0.0
- CODESYS Communication, Version 4.6.0.0
- CODESYS Visualization, Version 4.8.0.0
- CODESYS SoftMotion, Version 4.18.0.0

OK Cancel

Follow any prompts to install the updates. Once complete close the installer.



Now we are ready to install the AK840M Package file which contains the .xml Files for the
AK840M. We need to open the Installer again. To download the files, click on this link:

https://anaheimautomation.com/media/anaheim/files/software/Kinco_Ethercat_ XML.zip

Reopen the Codesys Software

Click on Tools->CODESYS Installer

&Y CODESYS

File Edit View Project Build Online Debug | Tools | Window Help

Bl & o o %@ X M2 - CODEYSinstallen |
Library Repository...

Devices v 3 X Device Repository...

24 Visualization Element Repository

gr an

Visualization Style Repository...

Select Browse and find the “Kinco XMLs for AK84x 1.0.2.3 250210.package” file

#% CODESYS Installer

CODESYS 643.5.21.0

Location 2 ————
C:\Program Files\CODESYS 3.5.21.0\CODESYS [ Browse 1 | » Start

Chanriel for Setups Chanriel for Add-ons Update Mode
Releases ~ Releases - Al -

#* Install File(s)

Installed Browse Updates

0O Ssearch Y v =+

[ =& CODESYS Application Composer

[] 3% CODESYS Automation Server Connector
[ 58 CODESYS Base Libraries

[ 5% CODESYS C Code Integration

[0 22 CODESYS CANopen

[ 58 CODESYS CFC

[ &% CODESYS Code Generator ARM

[ 5% CODESYS Code Generator ARME4

Copyright @ 2024 CODESYS Development GmbH Read-Only Mode (Restart as Administrator)
L

Select the Installation and click Continue



% Select Installation

Select the installation into which the add-on "Kinco XMLs for AKS84x, 1.0.2.3" should be
inztalled:

ﬂ CODESYS 64 35210

Continue Cancel

Click OK on Confirmation Required

™ £

Confirmation Required

The following operations will be performed,
Click OK to proceed with the changes listed below.

==== Install Packages ====
Install Packages (Silent=False, IncludeDependencies=False)

InstaliationPath: "C:\Program Files\CODESYS 3.5.2 L.ONCODESYS'
- Kinco XMLs for AKB4x, Version 1.0.2.3 ['Ch\Users\jpibuhOneDrive\Desktop\Kinco XMLs for AK84x 1.0.2.3 250210.package’)

OK Cancel

Check the “l want to continue despite the missing signature(s)” and click Continue

% Install packages

/\Kinco XMLs for AK84x 1.0.23 Kinco XMLs for AK84x 1.0.2.3

Signature

Mo signature was found in package,

| want to continue despite of the missing signature(s) | Continue Cancel

Close Codesys (The install will start without having to click OK here)



% Package Installation

Please close the following applications before continuing:

- 'CODESYS.exe’

Terminate all processes %

OK Cancel

b

When finished Click OK, then close the installer

e

Install packages

The add-ons were successfully installed.

OK

Reopen Codesys and the Installer. Verify at the bottom of the Add-ons Installed list, Kinco
XMLs for AK84x (ver 1.0.2.3) is listed. Close the Installer



#% CODESYS Installer

Version
CODESYS 64 3.5.21.0

Loestian
C:\Program Files\CODESYS 3.5.21.0\CODESYS

Chinnel for Setups Chignnel for Add-ons Updai
Releases ~ Releases - Al

[ Browse 1 | » Start

Installed Browse Updates
o
O Search Xk &
[ =2 CODESYS SoftMotion 4.17.0.0

[ &% CODESYS String Libraries
[ 2 CODESYS Target Settings Export 4000
[0 5% CODESYS Trace

[] 32 CODESYS Usage Analysis 1.2.0.0
[ & CODESYS Visualization

[ 5% CODESYS Visualization Support

[ 58 Kinco XMLs for AKB4x

LCopynght © 2024 CODESYS Development GmbH Read-Only Mode (Restart as Administrator]

stall File(s) |

One last update is the library update after you create your first project.
Create a new Project

File->New Project...

@Y CODESYS

File | Edit View Project Build Online Debuc
' IQ] New Project... Ctrl+N
'|@ Open Project... Ctrl+0O
H Close Project

Click on Standard project, give your project a name and location. Click OK




:;E Mew Project

Categories Templates

1‘_] Libraries 2 ¥ S

1__] Prujects i' — E

Empty project  HMI praject Standard Standard
project project w...

A project containing one device, one application, and an empty implementation for PLC_PRG |

MName | Untitled1 |

Location |C:‘|.I‘Gnm'|._PLC Projects‘Codesys\Untitled 1| vl ]

[ ] coneel |

The Standad Project Box will pop up, Select the AKB40M-0808DTN/P in the Device drop
down list.

Standard Project X

You are about to create a new standard project. This wizard will create the following
— objects within this project:
- One programmable device as specified below
- A program PLC_PRG in the language specified below
- A cyclic task which calls PLC_PRG
- A reference to the newest version of the Standard library currently installed.

Device CODESYS Control Win V3 x64 (CODESYS)

AK840M-0808DTN/P

CODESYS Control RTE V3 (CODESYS)
CODESYS Control RTE V3 x64 (CODESYS)
CODESYS Control Win V3 (CODESYS)
CODESYS Control Win V3 x64 (CODESYS)
CODESYS HMI (CODESYS)

PLC_PRG in

| oK | Cancel

Select the PLC-PRG in Code of your choice. | am choosing Ladder (LD2)



Standard Project X

You are about to create a new standard project. This wizard will create the following
= objects within this project:
- One programmable device as specified below
- A program PLC_PRG in the language specified below
- A cydlic task which calls PLC_PRG
- A reference to the newest version of the Standard library currently installed.

Device | AKB40M-080BDTN/P (KINCO Electric (Shenzhen) Ltd.) v
PLC_PRG in |Structured Text (ST) N7
Continuous Function Chart (CFC)

Continuous Function Chart (CFC) - page-oriented

Function Block ﬁ gram iﬂ i

Ladder (LD2

Ladder Logic Diagram (LD)
Sequential Function Chart (SFC)

Structured Text (ST)

Select OK to start the project

Standard Project

Y¥ou are about to create a new standard project. This wizard will create the following
objects within this project:

- One programmable device as specified below

- & program PLC_PRG in the language specified below

- A cyclic task which calls PLC_PRG

- A reference to the newest version of the Standard library currently installed.

Device !AKB40M—USOSD'I'N,|'P (KIMCO Electric (Shenzhen) Lid.) ~ |

ELC_PRGin |Ladder (LD2) v

oK I | Cancel |

Double Click the Library Manager

Click on “Download Missing Libraries”

@Y Untitled1.project - CODESYS
File Edit View Project Libraries Build Online Debug Tools Window Help

BSEI& o DEX(MGALIN AN - 3 |# | Application [Device: PLCLogic] + @8 @ ) m W [[E62¢=°2 3 |o M |= |2
| (i vLibrary Manager x
Untitied1 |[E9 Add Library X Delete Library. | 5! Properties 7@ Detail Download Missing Libraries § 5] P Library (i Library itory @ Icon Legend... (2] Summary...
= (@ pevice (AKB40M-03080TNE) L JouDedes
= B0 pLc Logic
=) o Application Name Namespace Effective Version

(i) [Library Manager 0 3 3 _35_LICENSE 3.5.20.0
{# PLC_PRG (PRG) - () Breakpoi : 3 ons GmbH)  BPLog

= (& Task Configuration
B EtherCAT Task
= & MainTask
&) pLc_PrG
(@ His10,(Hs10),
@ ¢ 0Er.0)
@ ee_1Ee.1)
(@ LocaBus (Localbus)
() Modbus_Slave TCP (Modbus Slave TCP ETH!
[ EtherCAT (EtherCAT Master SoftMotion)
"3 SoftMotion General Axis Pool




It will list the libraries that need to be updated with a check box.

Click Download. This will install the missing components.

& Download missing lbraries

Library Status Download URLs

CmplLog, 3.5.17.0 (System) | Missing https:/fstore.codesys.comf{CODESYSLibs /Sy
CmpApp, 3.5.17.0 (System) | Missing https:jfstore.codesys.comf{CODESYSLibs /Sy
Component Manaager, 3.5,17.0 {System) [ Missing https:/fstore.codesys.comf/CODESYSLibs 5
SysFthernet, 3.5.20. 10 {CODESYS) | Missing https://store.codesys.com/CODESYSLibs/C
CrmplecTask, 3.5.20.0 (System) | Missing https:/fstore.codesys.com/CODESYSLibs /Sy
CAA Device Diagnosiz, 3.5.20.0 {CAA Technical Workgroup) | Missing https://store.codesys.com/CODESYSLibs/C

When finished, click Closed

% Download missing hbraries

Library Status Download URLs

|| CmpLog, 3.5.17.0 {(System) LE' Installed https:/fstore.codesys.com{CODESY!
£ CmpApp, 3.5.17.0 {System) [_[_il Installed https:/fstore.codesys.com/CODESY!
[l component Manager, 3.5.17.0 {System) [_EJ Installed https://store.codesys.comf{CODESY!
[] sysEthernet, 3.5.20. 10 (CODESYS) [_EI Installed https:ffstore.codesys.com{CODESY!
B CmplecTask, 3.5.20.0 (System) [_@ Installed https:/fstore.codesys.com/CODESY!
[l cAA Device Diagnosis, 3.5.20.0 {CAA Technical Workgroup) @ Installed https://store.codesys.com/CODESY!
Ol CmpAsyncMar, 3.5.17.0 (System) [_g Installed https:/{store.codesys.com/{CODESY!
£ >

Uninstall Cownload : Close




Then close the Library Manager

@Y Untitled1.project - CODESYS

File Edit View Project Libraries Build Online Debug Tools Window Help
BB & v~ % B X |44 el B B B - [ | #¥% | Application [Device: PLC

||

Devices v 3 x (i vbrary Manager | x
=43 Untitled1 v Add Library < Delete Library |5 Properties 3 Details | 5] Place
- lﬁ Device (AKB40M-0308DTN/P) Libraries used in application ‘Device.Application'
=80 PLC Logic
= ) Application Name
m Library Manager + @ 3SLicense = 3SLicense, 3.5.20.0 (CODESYS)
@ PLC_PRG (PRG) + @ BreakpointLogging = Breakpoint Logging Functions, 3.5.17.0 (3S - Smai

- @ Task Configuration + @ CAA Device Diagnosis = CAA Device Diagnosis, 3.5.20.0 (CAA Technicz
@6 EtherCAT_Task + [@ IODrvEtherCAT = IODrvEtherCAT, 3.5.17.0 (3S - Smart Software Solu'
- @ MainTask + @ IoStandard = IoStandard, 3.5.17.0 (System)
&) PLC_PRG + SM3_Basic = SM3_Basic, 4.18.0.0 (CODESYS)
HSIO (HSIO)
EXP_0 (EXP_0)
EXP_1 (EXP_1)

LocalBus (LocalBus)
Modbus_Slave_TCP (Modbus Slave TCP ETH1
[ EtherCAT (EtherCAT Master SoftMotion)
2 SoftMotion General Axis Pool

Apply power (24VDC) to the AK840M at this time.



Double click Device to get to the device settings.

Devices

~ 0 %

=5 Linfitled?
=[] Device (AK340M-0308DTN/F)
=&l PLC Logic
= a' Application
5 m Library Manager
[ PLC_PRG (PRG)
= @ Task Configuration
%2 EtherCAT Task
=¥ MainTask
; -] PLC_PRG
[ Hs1o (Hs10)
[ exp_oExP_0)
[ er_1eP )
ﬂj LocalBus (LocalBus)
3 ﬂj Modbus_Slave_TCP (Modbus Slave TCP ETH1)
ﬁj EtherCAT (EtherCAT Master SoftMotion)
"% SoftMotion General Axis Poal

Choose the Communication Settings tab.

Choose the Scan Network tab.

-

~ & %|| [f] Device x|

Communication Settings Scan Network | Gateway - | Device -

Applications

Backup and Restore

----

Gateway

~|  |parrREn-pC

Files
. Log
= I
sy
- PLC Settings IP-Address:
g localhost
PLC Shell
| Port
1217

Users and Groups
Access Rights

Symbol Rights

| Software metrics for license
determination

IEC Objects

Press ENTER to set active path




Select the AK840M and Click OK.

1 o

Select Device

Select the Network Path to the Controller

= -jfgg Gateway-1 (Scanning...)
@ axss04a [009D]

Device Name:
Gateway-1

Scan Network

Driver: LI
ITCP/IP

IP-Address:
localhost

Port:
1217

[] Hide nan-matching devices, filter by Target ID

(e Cancel

The AK840M should now show as Active AK840M (Active).And both indicators should be
Green. This shows that the AK840M is connected correctly to the PC.

Gateway

AKB40AA (active v|

IP-Address:
localhaost

Part
1217

Device Name:
ARB40AA

Device Address:
008D

Target ID:
10A8 0003

Target Type:
4102

TargetVendor:
KINCO Hlectric (Shenzhen) Ltd.

TargetVersion:
3.5.20.20




If you want to change the IP Address of the AK840M,

Double Click on the Device and Select PLC Parameters, and expand EtherNET1

® Dual Axis.project* - CODESY
File Edit View Project Build Online Debug Tools Window Help
B Hd &~ BX(AALIN 97
Devices v 2 x
S5 Dualaxis -
_,_,Eﬂ Device (AKB40M-0B08DTN/P)
= Bl PLC Logic
= €} Application
() Library Manager
[2] pLc_prG (PRG)
= {#§ Task Configuration
S EtherCAT Task
= & MainTask
&) pc_PrG
(@ Hsto (Hst0)
@ o0 @r_0)
@ er_1@r_y

(# LocalBus (LocalBus)
(# Modbus_Slave_TCP (Modbus Slave TCP ETH1)
= [ EtherCAT (EtherCAT Master SoftMotion)
= X3 Kinco_FD (FD Drive)
M@ SM_Drive_GenericDSP402 (SM_Drive_GenericDSP402)
= Xioa Kinco_FD_1 (FD Drive)
H@P SM_Drive_GenericDSP402_1 (SM_Drive_GenericDSP402)
"3 SoftMotion General Axis Pool

Users and Groups

Access Rights

Symbol Rights

Software metrics for license
determination

IEC Objects

PLC Parameters

Task Deployment

Status

Information

Now Log Into the AK840M —

® Dual Asis.project* - CODESYS

File  Edit Project

A& o

View Build  Online

Debug
D@ X |44

Tools  Window

e

Help

B B B | £3- (7' | #¥ | Application [Device: PLC Logic]

f»-'\'

% |G |£3- 3% | Application [Device: PLC Logic] ~ @8 % ), u W[ o> W | w
(@ Device x
Communication Settings Parameter Type Value Default Value Unit  Description
. = [l EtherNET1 Set value, Click 'Write Parameter', Stop PLC to make it works
Applicaions # 1P Address
Backup and Restore : :
teway
Files + [ EtherNET2 Set value, Click 'Write Parameter', Stop PLC to make it works
+ [ Date And Time
Log # [ System Information
# [ BatteryStatus
PLC Settings.
PLC Shell

It will ask you to replace the current application, click Yes to download the latest code

An application 'Application’ is currently on the PLC, As there is no matching
compile information, this existing application needs to be replaced.

Click "fes' to download the latest code or ‘No' to abort.

Dietails...




The Current values will load onto the screen and the device will show connected and will

be in stop mode.

If you want to change the IP, write the new address in the “Prepared Value” column on the

correct line.

Then Click on Write Parameters in the Top Right of the window.

> xis
File Edit View Project Build Online Debug Tools Window Help
e @ & - LR R AL - ds
| Devices v & X | [ pevice x
=3 Dualans =
- & ([ Devie [comected] (AKBAOM-0B08DTN) Communication Settings
= @0 pLcLoge
- © Application [stop] Applications
9 Liory Manager Backup and Restore
PLC_PRG (PRG)
Task Configuration e
58, EtherCAT Task
= G & MainTask Log
&) pcprG
S (@ wsto gisio) PLC Settings
S oe_0@e.0
Be_1 BF_1) PLC Shell
& (i LocalBus (LocalBus)
S ( Modbus_Slave TCP (Modbus Slave TCP ETHI) \sete dnd Gaos
= A EtherCAT (EtherCAT Master Softiotion) e
= AA¥m Kinco_FD (FD Drive)
AN sM_Drive_GenericDSP402 (M _Prive_GenencdsP4d | | symbol rights
=¥ Kinco_FD_1 (FD Drive)
ARG g sM_Drive_GenericDSP402_1 (SM_Drive_GenericD: Software metrics for license
- determination
53 SoftMotion General Axis Pool
IEC Objects
| [SpT—
Task Deployment

L

When accepted the new value will show in the Current Value

>
File Edt View Project Build Online Debug Tools Window Help
-2~ A= 44 05 a4 0 B0 &
v & X || [ Device x
5 Devie [comected] (AKBAOW-08080TN) Communication Settings
1 PLC Loge sorica
pplications
= &) Application [stop]
{89 orary Mansger Backup and Restore
PLC_PRG (PRG)
# Task Configuration e
5S4 EthercAT Task
= S MainTask Log
&) picpre
S @ wsto gisto) PLC Settings
PLC Shell

(@ Modbus_Slave_TCP (Modbus Slave TCP ETH1)
= A[@g EtherCAT (EtherCAT Master SoftMotion)
= A Kinco_FD (FD Drive)
AR ; sM_Drive_GenericDsP402 (SM_Drive_GeneridDSP4.
= A3 Kinco_FD_1 (FD Drive)
AW ; 5M_Drive_GenericDSP402_1 (SM_Drive_GenericD:
'3 SoftMotion General Axis Pool

Users and Groups.

Access Rights

Symbol Rights

Software metrics forlicense
determination

IEC Objects

PLC Parameters

Application [Device: PLC Logic] ~ » e N
Write Parameters.
Parameter Type Current Value Prepared Value Value Default Value Unit  Description
= [ EtherNET1 Set value, Click 'Write Parameter', Stop PLC to make it works
# 1P Address STRING 192.168.1.157 192,163,115 ‘192,168,110 '192.168.1.100
# Netmask STRING '255.255.255.0' '255.255.255.0° '255.255.255.0'
# Gateway STRING '192.168.1.252 '192.168.1.1' '192.168.1.1'
* [ EtherNET2 Set value, Click 'Write Parameter’, Stop PLC to make it works
# [ Date And Time
# [ System Information
+ (22 BattenyStatus
Application [Device: PLC Logic] ~ % €% ) u %
Write Parameters
Parameter Type Current Value  Prepared Value Value Default Value Unit  Description
= [ EtherNET1 Set value, Click ‘Write Parameter’, Stop PLC to make it works
# [P Address STRING '192.168.1.158' '192.168.1.100' '192.168.1.100
# Netmask STRING 255.255.255.0° '255.255.255.0  '255.255.255.0
# Gateway STRING '192.168.1.252 9216818 '192.168.L1
# [ EtherNET2 Set value, Click 'Write Parameter', Stop PLC to make it works
* [ Date And Time
* [ System Information
+

(4 BatteryStatus

You are now ready to start programming the AK840 Controller.




